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of the fuser unit might be high and could damage your skin. 

When you open the front cover and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

4. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to redistribute the toner.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

5. Slide the toner cartridge back into the machine. 
6. Holding the handle on the paper transfer belt, align it with the slots on 

the inside of the front cover.

7. Lower the paper transfer belt until it is parallel with the front cover and 
firmly seated.

8. Close the front cover. Ensure that the cover is securely closed. 
If the front cover is not completely closed, the machine will not 
operate. 

TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the below guidelines. 
• Ensure that the adjustable guides are positioned correctly (See "Loading 

paper in the tray" on page 37).
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media (See "Setting the paper Type and 

Size" on page 41).
• Ensure that the recommended side of the print media is facing up in the 

tray, or facing down in the multi-purpose tray.
• If paper jams occur frequently when you print on A5/B5-sized paper: 

Load the paper into the tray with the long edge facing the front of the 
tray.

If load the paper this way, printing both sides of the paper (duplex) is not 
supported.
In the Printing Preferences window, set the page orientation to be 
rotated 180 degrees (See "Opening printing preferences" on page 44).



Troubleshooting_ 67

CLEARING PAPER JAMS
When a paper jam occurs, a warning message appears on the display. 

To avoid tearing the paper, pull the jammed paper out slowly and 
gently. Follow the instructions in the following sections to clear the 
jam. 

In tray 1
Click this link to open an animation about clearing a jam.

If paper is jammed in the paper feed area, follow the steps below to release 
the jammed paper.
1. Using the handle, completely open the front cover.

2. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

3. Close the front cover.
If the front cover is not completely closed, the machine will not 
operate. 

4. Pull out tray 1.

5. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

6. Insert tray 1 back into the machine until it snaps into place. Printing 
automatically resumes.

In optional tray
Click this link to open an animation about clearing a jam.

This section explains the method of removing jammed paper in the 
optional tray 2. Please refer to the below method for other optional 
tray, since the method is same for all optional trays.

1. Pull out optional tray 2 open.
2. Remove the jammed paper by pulling in the direction shown. To avoid 

tearing the paper, pull it out gently and slowly.
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If the paper does not move when you pull or if you do not see the paper 
in this area, stop and go to the next step.

3. Using the handle, completely open the front cover.
4. Remove the jammed paper by pulling in the direction shown. To avoid 

tearing the paper, pull it out gently and slowly.

5. Close the front cover and insert the trays back into the machine. Printing 
automatically resumes.

If the front cover is not completely closed, the machine will not 
operate. 

In the multi-purpose tray
Click this link to open an animation about clearing a jam.

When you print using the multi-purpose tray and the machine detects 
that there is either no paper or that the paper has been improperly 
loaded, follow the next steps to release the jammed paper.

1. If the paper is not feeding properly, pull the paper out of the machine.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to step 3.

2. Open and close the front cover to resume printing.
If the front cover is not completely closed, the machine will not 
operate. 

3. Using the handle, completely open the front cover.

4. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

• Do not touch the green surface, the OPC drum or the front of 
the toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this 
area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, 

the OPC drum can be exposed to light. This will cause damage 
to the OPC drum. Close the front cover when the installation 
needs to be halted for any reason.

5. Close the front cover to resume printing.
If the front cover is not completely closed, the machine will not 
operate. 

In the fuser unit area
Click this link to open an animation about clearing a jam.

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the top cover.
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2. Open the inner cover using the handle on it.

Do not touch the fuser inside the inner cover. It is hot and could 
cause burns! The fuser's operating temperature is 180°C (356°F). 
Take care when removing paper from the machine. 

3. Pull up the paper jam lever to loose the fusing part of the fuser unit and 
carefully take the jammed paper out of the machine.

4. Press down the paper jam lever to fasten the fusing part.
5. Close the inner cover.

Before closing the inner cover, the jam lever must be fastened first 
(step4). Otherwise, paper jam can occur. 

6. After removing the jammed paper, check for paper which may be 
jammed in other parts of the machine.

7. Close the top cover. Ensure that the cover is securely closed.
If the top cover is not completely closed, the machine will not 
operate. 

In exit area
Click this link to open an animation about clearing a jam.

1. Open and close the front cover. The jammed paper is automatically 
ejected from the machine.

2. Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and see "In the fuser unit area" on page 68.

3. Open and close the front cover to resume printing.
If the front cover is not completely closed, the machine will not 
operate. 

In the duplex unit area 
Click this link to open an animation about clearing a jam.

1. Using the handle, completely open the front cover.

Be careful not to scratch the surface of the paper transfer belt. 

2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.
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3. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

4. Holding the handle on the paper transfer belt, align it with the slots on 
the inside of the front cover.

5. Lower the paper transfer belt until it is parallel with the front cover and 
firmly seated.

6. Close the front cover to resume printing.
If the front cover is not completely closed, the machine will not 
operate. 

 UNDERSTANDING DISPLAY MESSAGES
Messages appear on the Smart Panel program window or on the control 
panel display to indicate machine status or errors. Refer to the tables below 
to understand the messages meaning to correct the problem, if necessary. 
Messages and their explanations are listed in alphabetical order.

• If a message is not in the table, reboot the power and try the 
printing job again. If the problem persists, call for service.

• When you call for service, provide the service representative with 
the contents of display message.

• Some messages may not appear in the display depending on the 
options or models.

• [error number] indicates the error number.
• [tray type] indicates the tray number. 
• [media type] indicates the media type.
• [media size] indicates the media size.
• [color] indicates the color of toner or imaging unit.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Adjusting Color
Registration

The machine is 
adjusting the color 
registration.

Wait a few minutes.

BOOTP problem
Auto IP Run

The IP address 
assignment is failed. 
This happens, when 
Auto IP for BOOTP is 
set in SyncThru™ 
Web Service.

 Change the IP address 
assignment method to 
DHCP or Static. If you do 
not change this option, 
the BOOTP server 
continually asks to assign 
the IP Address.

BOOTP problem
Reconfigure DHCP

The IP address 
assignment is failed. 
This happens, when 
Auto IP for BOOTP is 
not set in SyncThru™ 
Web Service.

Change the IP address 
assignment method to 
DHCP or Static. If you do 
not change this option, 
the BOOTP server 
continually asks to assign 
the IP Address.

Calibrating
image density…

The machine is 
calibrating the image 
density. 

Wait a few minutes.

DHCP problem: 
Auto IP Run

The IP address 
assignment is failed. 
This happens, when 
Auto IP for DHCP is 
set in SyncThru 
Web™ Service.

Change the IP address 
assignment method to 
BOOTP or Static. If you 
do not change this option, 
the DHCP server 
continually asks to assign 
the IP Address.

DHCP problem
Reconfigure 
BOOTP

The IP address 
assignment is failed. 
This happens, when 
Auto IP for DHCP is 
not set in SyncThru™ 
Web Service.

Change the IP address 
assignment method to 
BOOTP or Static. If you 
do not change this option, 
the DHCP server 
continually asks to assign 
the IP Address.
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Error [error number]
[color] toner

The indicated toner 
cartridge is installed 
improperly, or the 
connector is polluted.

Reinstall the 
Samsung-genuine toner 
cartridge two or three 
times to confirm it is 
seated properly. Or clean 
the connector. If the 
problem persists, contact 
the service 
representatives.

Error [error number]
Turn off then on 

A systematic error has 
occurred

Reboot the power and try 
the printing job again. If 
the problem persists, call 
for service.

Install Toner The indicated toner 
cartridge is installed 
improperly, or not 
installed.

Reinstall the toner 
cartridge two or three 
times to confirm it is 
seated properly. If the 
problem persists, the 
toner cartridge is not 
being detected. Contact 
the service 
representatives.

Load [tray number] 
with
[media size][media 
type]

There is no 
corresponding paper 
in the corresponding 
tray.

Load corresponding 
paper in the 
corresponding tray. 
(Page 4.4)

Network Problem:
IP Conflict

The IP address is 
used elsewhere. 

Check the IP address or 
obtain a new IP address.

Not Compatible
[color] toner

The indicated toner 
cartridge is not 
suitable for your 
machine.

Install the corresponding 
toner cartridge with a 
Samsung-genuine 
cartridge (See "Replacing 
the toner cartridge" on 
page 82).

Not Compatible
Transfer belt

The transfer belt is not 
suitable for your 
machine.

Install the 
Samsung-genuine 
transfer belt. If the 
problem persists, contact 
the service 
representatives (See 
"Replacing the paper 
transfer belt" on 
page 83).

Not Installed
Transfer belt

The transfer belt is not 
installed.

Reinstall the Samsung 
-genuine transfer belt two 
or three times to confirm 
it is seated properly. If the 
problem persists, the 
transfer belt is not being 
detected. Contact the 
service representatives 
(See "Replacing the 
paper transfer belt" on 
page 83).

MESSAGE MEANING SUGGESTED
SOLUTIONS

Not proper room
temp. Move set

The machine is in a 
room with improper 
room temperature. 

Move the machine to a 
room with proper room 
temperature (See 
"Environmental 
specifications" on 
page 87).

Output bin Full
Remove paper

The output tray is full. 
Or the sensor is not 
facing down.

Remove papers from the 
output tray, the machine 
resumes printing. Or 
make sure the sensor is 
facing down. If the 
problem persists, call for 
service.

Paper Empty
in [tray number] 

There is no paper in 
the indicated tray.

Load paper in the tray. 
(See "Loading paper in 
the tray" on page 37).

Paper Jam 
bottom of duplex

Paper has jammed 
during duplex printing. 
This is applicable only 
to machines with this 
feature. 

Clear the jam (See "In the 
duplex unit area" on 
page 69).

Paper Jam 
in exit area

Special print media 
has jammed in the 
paper exit area.

Clear the jam (See "In 
exit area" on page 69).

Paper Jam 
inside machine

Paper has jammed 
inside the machine.

Clear the jam (See "In the 
fuser unit area" on 
page 68).

Paper Jam
in MP Tray

Paper has jammed in 
the multi-purpose tray.

Clear the jam (See "In the 
multi-purpose tray" on 
page 68).

Paper Jam
in Tray1

Paper has jammed in 
the paper feed area 
and inside the 
machine.

Clear the jam (See "In 
tray 1" on page 67).

Paper Jam
in Tray2

Paper has jammed in 
the optional tray.

Clear the jam (See "In 
optional tray" on 
page 67).

Prepare new
Transfer belt

The life of the transfer 
belt will be expired 
soon.

Replace the transfer belt 
with a new one. Contact 
the service 
representatives.

Prepare Toner Small amount of toner 
is left in the indicated 
cartridge. The 
estimated cartridge 
life of toner is close.

Prepare a new cartridge 
for a replacement. You 
may temporarily increase 
the printing quality by 
redistributing the toner 
(See "Redistributing 
toner" on page 65).

Pulled Out
[tray number] 
Cassette

The indicated tray 
cassette is not 
inserted, or not 
properly closed.

To close the tray, lower 
the rear edge, align it with 
the slot, and slide it into 
the printer.

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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Replace new 
Fuser unit

The life of the fuser 
unit has expired.

Replace the fuser unit 
with a new one. Contact 
the service 
representatives.

MESSAGE MEANING SUGGESTED
SOLUTIONS

Replace Toner The indicated toner 
cartridge has almost 
reached its estimated 
cartridge life. The 
machine might stop 
printing. 

Estimated
cartridge life 
means the 
expected or 
estimated toner 
cartridge life, 
which indicates 
the average 
capacity of 
print-outs and is 
designed 
pursuant to 
ISO/IEC 19798. 
The number of 
pages may be 
affected by 
operating 
environment, 
printing interval, 
media type and 
media size. 
Some amount of 
toner may 
remain in the 
cartridge even 
when red LED is 
turned on 
appears and the 
printer stops 
printing.

• If Stop, Continue or 
Mono Only appears in 
the LCD display, 
choose one of them. If 
you select Stop, the 
printer stops printing 
and you cannot print 
any more without 
changing the cartridge. 
If you select Continue,
the printer keeps 
printing but the printing 
quality cannot be 
guaranteed. If you 
select Mono Only, the 
machine prints the 
data in black only.
Replace the toner 
cartridge for the best 
print quality when this 
message appears. 
Using a cartridge 
beyond this stage can 
result in printing quality 
issues (See 
"Replacing the toner 
cartridge" on page 82).

Samsung does 
not recommend 
using 
non-genuine 
Samsung toner 
cartridge such as 
refilled or 
remanufactured.
Samsung cannot 
guarantee 
non-genuine 
Samsung toner 
cartridge's
quality. Service 
or repair required 
as a result of 
using 
non-genuine 
Samsung toner 
cartridges will not 
be covered 
under the 
machine 
warranty.

• If the machine stops 
printing, replace the 
toner cartridge (See 
"Replacing the toner 
cartridge" on page 82).

MESSAGE MEANING SUGGESTED 
SOLUTIONS
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SOLVING OTHER PROBLEMS
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Power problems
Click this link to open an animation about clearing a jam.

CONDITION SUGGESTED SOLUTIONS

The machine is not 
receiving power, 
or the connection 
cable between the 
computer and the 
machine is not 
connected properly.

• Plug in the power cord and switch on the 
power-switch.

• Disconnect the machine cable and reconnect 
it.
- For Local Printing

- For Network Printing

Self Diagnostics
Please wait

The engine in your 
machine is checking 
some problems 
detected.

Please wait a few 
minutes.

Self Diagnostics
mode

The engine in your 
machine is checking 
some problems 
detected.

Please wait a few 
minutes.

Sleeping... The machine is in the 
power save mode.

When data is received, it 
switches to on-line 
automatically.

Updating Data
Please Wait...

• The machine is 
updating data.

• This message can 
also appear when 
priniting on a paper 
smaller than A4, 
such as envelope 
or B5. In this case, 
the machine is 
adjusting the 
setting for best print 
result. 

Wait a few minutes.

MESSAGE MEANING SUGGESTED
SOLUTIONS
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Paper feeding problems
CONDITION SUGGESTED SOLUTIONS

Paper jams during 
printing.

Clear the paper jam (See "Clearing paper jams" 
on page 67).

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray (See "Print media specifications" on 
page 89).

• Make sure that you are using the correct type 
of paper (See "Print media specifications" on 
page 89).

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine (See "Print media specifications" on 
page 89).

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose 
tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine (See "Print media 
specifications" on page 89).

• There may be debris inside the machine. 
Open the front cover and remove any debris.

Transparencies stick 
together in the paper 
exit.

Use only transparencies specifically designed 
for laser printers. Remove each transparency as 
it exits from the machine.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

Printing problems

CONDITION POSSIBLE
CAUSE

SUGGESTED 
SOLUTIONS

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default machine.

Select your machine as your 
default machine in your 
Windows.

Check the machine for the following:
• The front cover is not closed. Close the front 

cover.
• Paper is jammed. Clear the paper jam (See 

"Clearing paper jams" on page 67).
• No paper is loaded. Load paper (See "Loading 

paper in the tray" on page 37).
• The toner cartridge is not installed. Install the 

toner cartridge.
• Remove the protection sheet on the paper 

transfer belt. Refer to Quick Install Guide.
• Remove the sealing tape from the toner 

cartridge. Refer to Quick Install Guide.
If a system error occurs, contact your service 
representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the machine 
cable and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different machine cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly.

Check the Printing 
Preferences to ensure that 
all of the print settings are 
correct (See "Opening 
printing preferences" on 
page 44).

The printer driver 
may be incorrectly
installed.

Repair the machine software 
(See "Installing USB 
connected machine’s driver" 
on page 23).
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(Continued) The 
machine does not 
print.

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a 
service representative.

The document size 
is so big that the 
hard disk space of 
the computer is 
insufficient to 
access the print job.

Get more hard disk space 
and print the document 
again.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper option 
that was selected in 
the Printing 
Preferences may 
be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the Printing Preferences.
Select the correct paper 
source. See the printer 
driver help screen (See 
"Opening printing 
preferences" on page 44).

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of 
the page or try adjusting the 
print quality settings.

Half the page is 
blank.

The page 
orientation setting 
may be incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

CONDITION POSSIBLE
CAUSE

SUGGESTED
SOLUTIONS

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine cable 
is loose or 
defective.

Disconnect the machine 
cable and reconnect. Try a 
print job that you have 
already printed successfully. 
If possible, attach the cable 
and the machine to another 
computer that you know 
works and try a print job. 
Finally, try a new machine 
cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

If you are in a DOS 
environment, the 
font setting for your 
machine may be 
set incorrectly.

Change the language 
setting (See "Changing font 
setting" on page 35).

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary.
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such 
as the controller or 
the board, may be 
defective.

Contact a service 
representative.

The machine 
does not print 
PDF file correctly. 
Some parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As 
Image from the Acrobat 
printing options. 

It will take longer to 
print when you print a 
PDF file as an image.

CONDITION POSSIBLE
CAUSE

SUGGESTED 
SOLUTIONS
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. 

The print quality 
of photos is not 
good. Images are 
not clear.

The resolution of 
the photo is very 
low.

Reduce the photo size. If 
you increase the photo size 
in the software application, 
the resolution will be 
reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size setting 
do not match.

Set the correct size in the 
Paper tab > Size > Edit... in 
the Printing Preferences
(See "Opening printing 
preferences" on page 44).

CONDITION SUGGESTED SOLUTIONS

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life (See "Redistributing toner" 
on page 65). If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper specifications; 
for example, the paper may be too moist or 
rough (See "Print media specifications" on 
page 89).

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning (See "Cleaning the inside" on 
page 62).

• The surface of the LSU part inside the 
machine may be dirty (See "Cleaning the 
inside" on page 62).

Toner specks

A aB bC c
A aB bC c
A aB bC c
A aB bC c
A aB bC c

• The paper may not meet specifications; for 
example, the paper may be too moist or rough 
(See "Print media specifications" on page 89).

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

CONDITION POSSIBLE
CAUSE

SUGGESTED
SOLUTIONS

Dropouts

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper (See "Print
media specifications" on page 89).

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click Paper tab, 
and set type to Thick Paper (See "Opening 
printing preferences" on page 44).

• If these steps do not correct the problem, 
contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine (See 
"Cleaning the inside" on page 62).

• The paper path may need cleaning (See 
"Cleaning the inside" on page 62).

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the toner 

cartridge inside the machine has probably 
been scratched. Remove the toner cartridge 
and install a new one (See "Replacing the 
toner cartridge" on page 82).

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty (See "Cleaning the 
inside" on page 62).

Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper (See "Print

media specifications" on page 89).
• Check the environmental conditions: very 

dry conditions (low humidity) or a high level 
of humidity (higher than 80% RH) can 
increase the amount of background shading.

• Remove the old toner cartridge and, install a 
new one (See "Replacing the toner 
cartridge" on page 82).

CONDITION SUGGESTED SOLUTIONS
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Toner smear If toner smears on the page: 
• Clean the inside of the machine (See 

"Cleaning the inside" on page 62).
• Check the paper type and quality (See "Print 

media specifications" on page 89).
• Remove the toner cartridge and then, install 

a new one (See "Replacing the toner 
cartridge" on page 82).

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If you 

still have the same problem, remove the 
toner cartridge and, install a new one (See 
"Replacing the toner cartridge" on page 82).

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background 
scatter

A
Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or in Printing Preferences (See 
"Opening printing preferences" on page 44).

Misformed 
characters

If characters are improperly formed and 
producing hollow images, the paper stock may 
be too slick. Try different paper (See "Print 
media specifications" on page 89).

CONDITION SUGGESTED SOLUTIONS

Page skew
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• Ensure that the paper is loaded properly.
• Check the paper type and quality (See "Print 

media specifications" on page 89).
• Ensure that the guides are not too tight or too 

loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl (See "Print media specifications" on 
page 89).

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality (See "Print 

media specifications" on page 89).
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

• Check for leaking toner. Clean the inside of 
the machine (See "Cleaning the inside" on 
page 62).

• Clean the fuser belt (See "Cleaning a fuser 
belt" on page 62).

• The toner cartridge has reached its estimated 
cartridge life.

Solid Color or 
Black pages

A
• The toner cartridge may not be installed 

properly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. 

Remove the toner cartridge and install a new 
one (See "Replacing the toner cartridge" on 
page 82).

• The machine may require repair. Contact a 
service representative.

CONDITION SUGGESTED SOLUTIONS
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Common PostScript problems
The following situations are PS language specific and may occur when 
several printer languages are used.

PROBLEM POSSIBLE
CAUSE SOLUTION

PostScript file 
cannot be printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver (See "Installing 
USB connected 
machine’s driver" on 
page 23).

• Print a configuration 
page and verify that 
the PS version is 
available for printing.

• If the problem persists, 
contact a service 
representative.

“Limit Check Error” 
report prints.

The print job was 
too complex.

You might need to 
reduce the complexity of 
the page or install more 
memory (See "Installing 
a memory module" on 
page 85).

A PostScript error 
page prints.

The print job may 
not be PostScript.

Make sure that the print 
job is a PostScript job. 
Check to see whether 
the software application 
expected a setup or 
PostScript header file to 
be sent to the machine.

The optional tray is 
not selected in the 
driver.

The printer driver 
has not been 
configured to 
recognize the 
optional tray.

Open the PostScript 
driver properties, select 
the Device Settings tab, 
and set the tray option of 
the Installable Options
section to Installed.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

The resolution 
setting in the printer 
driver may not be 
matched with the 
one in Acrobat 
Reader.

Make sure that the 
resolution setting in your 
printer driver matches 
the one in Acrobat 
Reader.

Common Windows problems
CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the printer’s startup group, then 
restart Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

Loose toner • Clean the inside of the machine (See 
"Cleaning the inside" on page 62).

• Check the paper type and quality (See "Print
media specifications" on page 89).

• Remove the toner cartridge and then, install a 
new one (See "Replacing the toner cartridge" 
on page 82).

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Character Voids

A
Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications (See "Print media 
specifications" on page 89).

Horizontal stripes

A a B b C
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A a B b C

If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one (See "Replacing the toner cartridge" on 
page 82).

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin Paper (See "Opening 
printing preferences" on page 44).

An unknown image 
repetitively
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an 
altitude of 1,000 m (3,281 ft.) or above.
The high altitude may affect the print quality, 
such as loose toner or light imaging. Change the 
correct altitude setting to your machine (See 
"Altitude adjustment" on page 34).

CONDITION SUGGESTED SOLUTIONS
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Refer to Microsoft Windows User’s Guide that came with your 
computer for further information on Windows error messages.

Common Macintosh problems
CONDITION SUGGESTED SOLUTIONS

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

It will take longer to print when you print a 
PDF file as an image.

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X 10.3.2.

Update your MAC OS to MAC OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover 
page printing.

Mac OS cannot create the font during the cover 
page printing. The English alphabet and 
numbers are displayed normally on the cover 
page.

When printing a 
document in Mac OS 
with Acrobat 
Reader 6.0 or higher, 
colors print 
incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

Refer to Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.

Common Linux problems
CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occurred.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

Some color images 
come out all black.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.05) when the base color 
space of the document is indexed color space 
and is converted through CIE color space. 
Because Postscript uses CIE color space for 
Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 7.06 or later. You can find 
recent Ghostscript versions at 
www.ghostscript.com.

Some color images 
come out in 
unexpected colors.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.xx) when the base color 
space of the document is indexed RGB color 
space and it is converted through CIE color 
space. Because Postscript uses CIE color space 
for Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 8.xx or later. You can find 
recent Ghostscript versions at 
www.ghostscript.com.
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Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252.The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS (Common UNIX 
Printing System) server break the print job 
whenever print options are changed and then try 
to restart the job from the beginning. Since 
Unified Linux Driver locks the port while printing, 
the abrupt termination of the driver keeps the 
port locked and unavailable for subsequent print 
jobs. If this situation occurs, try to release the 
port by selecting Release port in Port 
configuration window.

When printing a 
document over the 
network in SuSE 9.2, 
the printer does not 
print.

The CUPS (Common UNIX Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp (Internet 
Printing Protocol) printing. Use the socket 
printing instead of ipp or install later version of 
CUPS (Common UNIX Printing System) 
(cups-1.1.22 or higher).

CONDITION SUGGESTED SOLUTIONS
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11.supplies and accessories
This chapter provides information on purchasing supplies  accessories and maintenance parts available for your machine.
This chapter includes:
• How to purchase
• Available supplies
• Available accessories
• Available maintenance Parts
• Replacing the toner cartridge

• Replacing the paper transfer belt
• Necessary Precautions to take when installing accessories
• Activating the added accessories in printer properties
• Upgrading a memory module

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

HOW TO PURCHASE
To order Samsung-authorized supplies  accessories and, maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine You can also visit www.samsung.com/supplies,
select your country/region and obtain information on calling for service.

AVAILABLE SUPPLIES
When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

TYPE AVERAGE YIELDa PART NAME

Standard
yield

• Average 
continuous black 
cartridge yield: 
2,500 standard 
pages (Black)

• Average 
continuous 
colored cartridge 
yield: 2,000 
standard pages 
(Yellow/Magenta/
Cyan)

C508(CLT-C508S): Cyan
M508(CLT-M508S): Magenta
Y508(CLT-Y508S): Yellow
K508(CLT-K508S): Black
Region Ab

b.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, 
Cyprus, Czech Republic, Denmark, Finland, France, Germany, 
Greece, Hungary, Italy, Macedonia, Netherlands, Norway, Poland, 
Portugal, Romania, Serbia, Slovakia, Slovenia, Spain, Sweden, 
Switzerland, UK. 

:
C5082(CLT-C5082S): Cyan
M5082(CLT-M5082S): Magenta
Y5082(CLT-Y5082S): Yellow
K5082(CLT-K5082S): Black

High yield • Average 
continuous black 
cartridge yield: 
5,000 standard 
pages (Black)

• Average 
continuous 
colored cartridge 
yield: 4,000 
standard pages 
(Yellow/Magenta/
Cyan)

C508(CLT-C508L): Cyan
M508(CLT-M508L): Magenta
Y508(CLT-Y508L): Yellow
K508(CLT-K508L): Black
Region Ab:
C5082(CLT-C5082L): Cyan
M5082(CLT-M5082L): Magenta
Y5082(CLT-Y5082L): Yellow
K5082(CLT-K5082L): Black

Paper 
transfer belt

When the transfer 
belt has worn out 
with abrasion, you 
need to change it. 
By this time you may 
be notified with the 
transfer belt-related 
message on the 
display.

• CLP-620 Series: CLT-T507
• CLP-670 Series: CLT-T508

To replace a toner cartridge see "Replacing the toner cartridge" on page 82.
Depending on the options and job mode used, the toner cartridge’s 
lifespan may differ.

You must purchase supplies, including toner cartridges, in the same 
country where you purchased your machine. Otherwise, supplies will 
be incompatible with your machine since the system configuration of 
these vary from country to country.

AVAILABLE ACCESSORIES
You can purchase and install accessories to enhance your machine’s 
performance and capacity.

a.Declared yield value in accordance with ISO/IEC 19798.

TYPE AVERAGE YIELDa PART NAME



ACCESSORY FUNCTION PART NAME

Memory module Extend your machine’s 
memory capacity.

• CLP-620 Series
- CLP-MEM201:

128 MB
- CLP-MEM202:

256 MB
• CLP-670 Series

- CLP-MEM150:
128 MB

- CLP-MEM160:
256 MB

- CLP-MEM170:
512 MB

Optional tray 2 If you are experiencing 
frequent paper supply 
problems, you can 
attach an additional 500 
sheet tray. You can 
print documents in 
various sizes and types 
of print materials.

CLP-S670A
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AVAILABLE MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition, the following parts 
will need to be replaced after printing the specified number of pages or 
when the life span of each item has expired.

PARTS AVERAGE YIELDa

a.It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

Fuser unit Approx. 100,000 pages ELA UNIT-FUSER

Paper Pickup roller Approx. 70,000 pages ROLLER-PICK UP

FCF friction pad Approx. 70,000 pages RPR-FRICTION-P
AD

To purchase maintenance parts, contact the supplier where you bought the 
machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer, or the retailer where you bought the machine. The 
warranty does not cover the replacement of any maintenance parts after 
their lifespan.

REPLACING THE TONER CARTRIDGE
Click this link to open an animation about replacing a toner cartridge.

The machine uses four colors and has a different toner cartridge for each 
one: yellow (Y), magenta (M), cyan (C), and black (K).
• The status LED and the toner-related message on the display indicate 

when each individual toner cartridges should be replaced. 
At this stage, the toner cartridge needs to be replaced. Check the type of the 
toner cartridge for your machine (See "Available supplies" on page 81).

1. Using the handle, completely open the front cover.

• Do not touch the green surface, the OPC drum or the front of 
the toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this 
area.

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, 

the OPC drum can be exposed to light. This will cause damage 
to the OPC drum. Close the front cover when the installation 
needs to be halted for any reason.

2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

3. Grasp the handles of the toner cartridge which needs to be changed and 
pull to remove the cartridge from the machine.

If you open the front cover, be careful not to touch the underneath 
the control panel (the lower part of the fuser unit). The temperature 

PART NAME
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of the fuser unit might be high and could damage your skin. 

When you open the front cover and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

4. Remove the new toner cartridge from its bag. 
• Don't use sharp objects, such as a knife or scissors, to open 

the toner cartridge package. You could damage the surface of 
the toner cartridge. 

• To prevent damage, do not expose the toner cartridge to light 
for more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.

5. Slowly shake the cartridge five or six times to distribute the toner evenly 
inside the cartridge. It will assure maximum copies per cartridge. 

6. Place the toner cartridge on a flat surface, as shown, and remove the 
paper covering the toner cartridge by removing the tape.

• For high yield toner cartridge:
Before installing the toner cartridge, make sure to remove the 
film.

• If toner gets on your clothing, wipe it off with a dry cloth and 
wash clothing in cold water. Hot water sets toner into fabric.

Do not touch the green surface, the OPC drum of the cartridge. 
Use the handle on the cartridge to avoid touching this area. 

7. Make sure that the color of the toner cartridge matches the color slot and 
then grasp the handles on the toner cartridge. Insert the cartridge until it 
clicks into place.

8. Holding the handle on the paper transfer belt, align it with the slots on 
the inside of the front cover.

9. Lower the paper transfer belt until it is parallel with the front cover and 
firmly seated.

10. Close the front cover. Make sure that the cover is securely closed. 
If the front cover is not completely closed, the machine will not 
operate. 

REPLACING THE PAPER TRANSFER BELT
After the life span of the paper transfer belt is complete, you have to replace 
it.
• The transfer belt-related message appears on the display, telling it's 

time for a replacement. 
• The Smart Panel program window appears on the computer telling you 

the paper transfer belt needs to be replaced. 
The life span of the paper transfer belt may be affected by operating 
environment, printing interval, media type, and media size.
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1. Using the handle, completely open the front cover.

• Do not touch the green surface, the OPC drum or the front of 
the toner cartridge, with your hands or any other material. Use 
the handle on each cartridge in order to avoid touching this 
area. 

• Be careful not to scratch the surface of the paper transfer belt.
• If you leave the front cover open for more than a few minutes, 

the OPC drum can be exposed to light. This will cause damage 
to the OPC drum. Close the front cover should the installation 
needs to be halted for any reason.

2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

3. Remove a new paper transfer belt from its bag. 
4. Remove the paper covering the paper transfer belt. 

• Do not use sharp objects, such as a knife or scissors, to open 
the paper transfer belt package. You could damage the surface 
of the paper transfer belt. 

• Be careful not to scratch the surface of the paper transfer belt.

5. Holding the handle on the new paper transfer belt, align it with the slots 
on the inside of the front cover.

6. Lower the paper transfer belt until it is parallel with the front cover and 
firmly seated.

7. Close the front cover to resume printing.
If the front cover is not completely closed, the machine will not 
operate. 

NECESSARY PRECAUTIONS TO TAKE WHEN 
INSTALLING ACCESSORIES
• Disconnect the power cord.

Never remove the control board cover while the power is turned on.
To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

• Discharge static electricity.
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

• Activating the added accessories in the PS driver properties.
After installing an accessory such as an optional tray, PS driver users 
must do the additional setting. Go to the PS printer properties and set 
the added accessory activated. 
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When installing accessories, the battery inside the machine is a 
service component. Do not change it by yourself.
There is a risk of an explosion if battery is replaced by an incorrect 
type. Dispose used batteries according to the instructions.

ACTIVATING THE ADDED ACCESSORIES IN 
PRINTER PROPERTIES
After installing added accessories, you need to select it in the printer 
properties of the printer driver in order to use it.
1. Install the driver (See "Installing USB connected machine’s driver" on 

page 23or "Installing network connected machine’s driver" on page 29).
2. Click the Windows Start menu.
3. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound >

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware >

Devices and Printers.
4. Right-click your machine.
5. For Windows XP/2003/2008/Vista, press Properties.

• For PS driver, select PS driver and right-click to open Properties.
For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.

If Printer properties item has  mark, you can select other 
printer drivers connected with selected printer.

6. In printer driver properties, select Device Options.
7. In printer driver properties, set the necessary options.
8. Click OK.

UPGRADING A MEMORY MODULE
Your machine has a dual in-line memory module (DIMM). Use this memory 
module slot to install additional memory.
The machine has one memory slots. When you are expanding the memory 
capacity, you can add a memory module to the vacant memory slot (See 
"Available accessories" on page 81).

Installing a memory module
1. Turn the machine off and unplug all cables from the machine.
2. Open the control board cover. Release the screw, then lift up the cover 

slightly and pull the cover to the right.

3. Take out a new memory module from its plastic bag.

4. Holding the memory module by the edges, align the memory module on 
the slot at about a 30-degree tilt. Make sure that the notches of the 
module and the grooves on the slot fit each other.

The notches and grooves illustrated above may not match those 
on an actual memory module and its slot.

5. Press the memory module into the slot with care until you hear a 'click'. 
Do not press the memory module strongly or the module may be 
damaged. If the module does not seem to fit into the slot properly, 
carefully try the previous procedure again.

6. Replace the control board cover and fasten the cover with the screw.

7. Reconnect the power cord and machine cable. Turn on the machine.
8. If you use the PS driver, you must activate the added memory in the PS 

driver properties
(See "Activating the added accessories in printer properties" on 
page 85).

Printing with the optional memory (CLP-670 Series 
only)

• You can only use this feature if you have installed the 512 MB 
optional memory. (CLP-670 Series only)

• After installing the optional memory, you can use the advanced 
printing features, such as proofing a job and specifying of printing 
a secure print job in the printer properties window.

Job Accounting
This option allows you to print with the given permission.
• User permission:  If you check this option, only users with user 

permission can start a print job.
• Group permission: If you check this option, only groups with group 

permission can start a print job.

• If you want to encrypt job accounting password, see 
"Activating the added accessories in printer properties" on 
page 85.

• Administrators can enable job accounting and configure 
permissions in SyncThru™ Web Admin Service.
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Job Settings 
This option allows you to choose how to print the printing file by using 
the optional memory. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your printer driver from the Select Printer list.

The basic print settings including the number of copies and print 
range are selected within the Print window. 

4. Access Printing Preferences (See "Opening printing preferences" 
on page 44).

5. Click the Advanced tab then select Job Settings.
6. Select the Print Mode you want.

• Normal: This mode prints without storing your document in the 
optional memory. 

• Proof: This mode is useful when you print more than one copy. 
You can print one copy first to check, than print the rest of copies 
later. 

• Confidential: This mode is used for printing confidential 
documents. You need to enter a password to print. 

7. Select OK.

Controlling the active job queue
All of the print jobs waiting to be printed are listed in the active job queue 
in the order you sent them to the printer. You can delete a job from the 
queue before printing, or promote a job to print sooner.

1. Press  on the control panel.
2. Press left/right arrow until Job Management appears and press OK.
3. Press left/right arrow until Active Job appears and press OK.
4. Press left/right arrow until the user’s name and file name you want to 

use appears and press OK.

If the select file is a confidential print job, enter the specified 
4-digit password.
Use the left/right arrow to enter digits. When you press OK,
cursor will move to the next character. When you finnish 
entering the password, press OK.
If you enter the incorrect password, Invalid Password
appears. Reenter the correct password.

5. Press the left/right arrow until the desired setting appears and press 
OK.
• Cancel: You can delete a file from the queue.
• Promote: You can select a job waiting in the active job queue 

and change its print order so that it can be printed sooner.
• Release: You can print a job scheduled to be printed at a 

specified time immediately. In this case, the job currently printing 
is stopped and the selected job will be printed. This function is 
available when the job is scheduled for later printing.

Release option appears only when you select a scheduled 
job.

6. When Yes appears, press OK.

Form file
Form overlay are images stored in the optional memory as a special file 
format that can be printed on any document. 

Creating new form files
1. Create or open a document containing text or an image for use in a 

new form file.
2. To save the document as a form file, access Printing Preferences

(See "Opening printing preferences" on page 44).
3. Click the Advanced tab, and select Advanced.
4. In the Advanced Output Options window, check Save as Form for 

Overlay.
5. Click Search.
6. Type a file name of up to eight characters in the File name box. 

Select the destination path and click Save.
7. Click OK or Print until you exit the Print window
8. A confirm message appears, click Yes to save.

The file is not printed. Instead, it is stored on your computer hard disk 
drive.

If you click NO, the machine prints your form without saving.

9. A confirm message appears, click Yes to save.
The form file size must be the same as the document you print with 
the form file.

File Policy
You can choose the file policy for generating file name before you 
proceed with the job through optional memory. If the optional memory 
already has the same name when you entered a new file name, you can 
rename or overwrite it.

1. Press  on the control panel.
2. Press the left/right arrow until Job Management appears and press 

OK.
3. Press the left/right arrow until File Policy appears and press OK.
4. Press the left/right arrow until the desired setting appears and press 

OK.
• Rename : If the optional memory already has the same file 

name when you entered a new file name, the file will be saved as 
a different file name that is automatically programmed.

• Overwrite : If the optional memory already has the same file 
name when you entered a new file name, the previous file will be 
recorded over with the new file.

5. Press OK.
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12. specifications
This chapter guides you about this machine’s specifications.
This chapter include:
• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications

The specification values here are based on preliminary data. See www.samsung.com/printer for current information.

HARDWARE SPECIFICATIONS

ITEM DESCRIPTION

Dimension Height 430.9 mm (16.96 inches) 

Depth 441.5 mm (17.38 inches) 

Width 424.9 mm (16.73 inches) 

Weight Machine with consumables • CLP 620 Series: 28.5 Kg ( 62.8 lbs)
• CLP 670 Series : 34 Kg ( 75 lbs)

Package weight Paper • CLP 620 Series: 2.95 Kg ( 6.50 lbs)
• CLP 670 Series : 3.38 Kg ( 7.45 lbs)

Plastic 0.95 kg (2.09 lbs)

ENVIRONMENTAL SPECIFICATIONS

ITEM DESCRIPTION

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Ready mode Less than 35 dB(A)

Printing mode • CLP 620 Series: Less than 51 dB(A) 
• CLP 670 Series : Less than 52 dB(A) 

Temperature Operation 15 to 30 °C (59 to 86 °F)

Storage -20 to 50 °C (-4 to 122 °F)

Humidity Operation 20 to 80% RH

Storage 0 to 90% RH

ELECTRICAL SPECIFICATIONS
Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.



ITEM DESCRIPTION

Power ratinga

a.See the rating label on the machine for the correct voltage, frequency (hertz) and type of current for your machine.

110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V

Power consumption Average operating mode Less than 550 W

Ready mode Less than 20 W

Power save mode Less than 8W

Power off mode Less than 1 W
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PRINT MEDIA SPECIFICATIONS

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHTa/CAPACITYb

TRAY1 / OPTIONAL TRAY MULTI-PURPOSE TRAY

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) 60 to 90 g/m2 (16 to 24 lb. bond) 
• 250 sheets of 80 g/m2(20 lb. 

bond) f or tray1. 
• 500 sheets of 80 g/m2(20 lb. 

bond) for optional tray.

60 to 163 g/m2 (16 to 43 lb. bond) 
• 100 sheets of 80 g/m2(20 lb. 

bond)
Legal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches) 60 to 90 g/m2 (20 to 24 lb. bond) 
• 250 sheets of 80 g/m2(20 lb. 

bond)
ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

Statement 140 x 216 mm (5.5 x 8.5 inches) Not available in tray1 / optional tray.

A6 105 x 148 mm (4.13 x 5.83 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) Not available in tray1 / optional tray. 75 to 90 g/m2 (20 to 24 lb. bond)
• 10 sheetsEnvelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Envelope C6 114 x 162 mm (4.49 x 6.38 inches)

Envelope No. 9 98 x 225 mm (3.87 x 8.87 inches)

Envelope 6 3/4 92 x 165 mm (3.62 x 6.5 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section 90 to 105 g/m2 (24 to 28 lb. bond)
• 250 sheets of 80 g/m2(20 lb. 

bond) f or tray1. 
• 500 sheets of 80 g/m2(20 lb. 

bond) for optional tray.

90 to 105 g/m2 (24 to 28 lb. bond)
• 40 sheets

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lb. bond)
• 250 sheets of 80 g/m2(20 lb. 

bond) f or tray1. 
• 500 sheets of 80 g/m2(20 lb. 

bond) for optional tray.

60 to 70 g/m2 (16 to 19 lb. bond)
• 100 sheets

Thicker paper Refer to the Plain 
paper section 

Refer to the Plain paper section Not available in tray1 / optional tray. 106 to 120 g/m2 (28 to 32 lb. bond)
• 10 sheets

Extra thick Refer to the Plain 
paper section 

Refer to the Plain paper section Not available in tray1 / optional tray. 120 to 170 g/m2 (32 to 46 lb. bond)
• 10 sheets

Transparency A4, Letter Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lb. bond)
• 10 sheets

Labelsc Refer to the Plain 
paper section

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb. bond)
• 10 sheets

Card stock Refer to the Plain 
paper section

Refer to the Plain paper section 171 to 220 g/m2 (46 to 59 lb. bond)
• 5 sheets
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Glossy Photo Refer to the Plain 
paper section

100 x 150 mm (4 x 6 inches) Not available in tray1 / optional tray. 111 to 220 g/m2 (30 to 59 lb. bond)
• 1 sheet

Minimum size (custom) 76 x 127 mm (3 x 5 inches)

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. If media weight is over 105 g/m2 (28 lb. bond), load a paper into the multi-purpose tray one by one.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 
c. Smoothness: 100 to 250 (sheffield).

TYPE SIZE DIMENSIONS
PRINT MEDIA WEIGHTa/CAPACITYb

TRAY1 / OPTIONAL TRAY MULTI-PURPOSE TRAY
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13.administrator’s guide (windows only)
This chapter gives helpful information and troubleshooting tips for system administrators using Samsung Installer.

OVERVIEW
Samsung provides convenient installation methods useful for 
administrators. Administrators can remotely install the machine driver to 
multiple client computers or use command window to install the driver at 
once. Administrators can also make their own installation package for 
distribution. 
Check the system requirements before installing the machine’s driver (See 
"System requirements" on page 22).

REMOTE INSTALLATION
Remote Installation is provided under Administrator Installation menu. It 
is provided for administrators to remotely install device drivers and 
application software to multiple client computers. To use remote installation, 
you must configure at least one group. Multiple client computers can be 
added to a group that has the same installation configuration. Installation 
configuration includes device drivers or application software to be installed, 
port used for printing, default printer, printer name, sharing information and 
etc.

For remote installation, all client computers must be joined to a 
domain or a workgroup and file sharing must be enabled to be 
accessed by remote installer software on both server and client sides. 
If you cannot access the client computers, you might need to disable 
the Firewall option on the client computers.

Domain remote installation
You need to be a member of domain administrator to use Domain 
Remote Installation.

1. Make sure that the machine is connected to the network or USB and 
powered on.

2. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation window 

appears.
• If the installation window does not appear, click Start and then Run.

Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

3. Select Administrator Installation > Remote Installation.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Client Group window appears. 
6. Click New Group.

To use remote installation, you need at least a group. If you have 
already created a group, load the group you want and go to step 16. 
• Edit Group: You can edit groups.
• Load Group: You can load groups. 
• Delete Group: You can delete groups.

7. Log on window appears. Select Domain Remote Installation and type 
in the administrator’s Domain, ID and Password.

If your company has no domain network environment, you can use 
Workgroup Remote Installation (See "Workgroup Remote 
Installation" on page 92).

8. Click Next.
9. Select Clients window appears. 
10.  Type in the group name in the Group Name field.
11. Add the client computers to be in the group to the right side panel. 

• You can click … button to search the client computers and add 
button to add a client computer by typing the IP address or the 
computer name of client.

• You can add up to 50 client computers in a group. If you want 
to add more than 50 client computers, you need to create more 
groups. 

• If the firewall is enabled on the client computer, access may be 
denied.

• The client computer’s operating system should be Windows 
2000 or higher.

• C drive must be shared as C$.
12. Select Software and Utilities to Install window appears.

Select the driver(s) and application software(s) you want to install and 
click Next.

13. Select Printer connection window appears. 
Select the printer connection type and click Next.
• If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

• The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

14. Confirm Group details window appears. 
Check the group information and click Next.

Location to save the group shows the path of default folder 
which stores the created group information. The group information 
file will be created as “<group_name>.RGI. You can change the 
path by clicking the Change button. 

15. Select Client Group window appears again.
16. Select the group(s) and click Next to start remote installation.

Remote installation begins, you can see the installation status from the 
window. 
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17. When installation is completed, Results of remote installation window 
appears. 
Check the result. For failed client computers, you can reinstall again by 
clicking the Reinstall button.

For failed client computers, you can check the log file which is 
created in the client computers.

Workgroup Remote Installation
You can also use remote installation method with workgroups. 
If your company has no domain network environment, you should use 
Workgroup Remote Installation.

If the client computer uses Windows Vista or higher, ID should be 
Administrator.

1. Make sure that the machine is connected to the network or USB and 
powered on.

2. Insert the supplied software CD into your CD-ROM drive.
• The software CD should automatically run and an installation window 

appears.
• If the installation window does not appear, click Start and then Run.

Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

3. Select Administrator Installation > Remote Installation.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Client Group window appears. 
6. Click New Group.

To use remote installation, you need at least a group. If you have 
already created a group, load the group you want and go to step 16. 
• Edit Group: You can edit groups.
• Load Group: You can load groups. 
• Delete Group: You can delete groups.

7. Log on window appears. Select Workgroup Remote Installation and 
type in the Workgroup, ID and Password.

• For Windows XP/2000/2003, the ID should be of a memeber of 
Administrators group for operating computers and for Windows 
Vista/2008/7, the ID should be of the default administrator 
account named Administrator. 

• You can also use Domain Remote Installation (See "Domain 
remote installation" on page 91).

8. Click Next.
9. Select Clients window appears. 
10.  Type in the group name in the Group Name field.
11. Add the client computers to be in the group to the right side panel. 

• You can click … button to search the client computers and add 
button to add the client computer by typing the IP address or 
the computer name of client.

• You can add up to 50 client computers in a group. If you want 
to add more than 50 client computers, you need to create more 

groups. 
• If the firewall is enabled on the client computer, access may be 

denied.
• The client computer’s operating system should be Windows 

2000 or higher.
• If you have grouped the client computers in a workgroup and 

you try to connect to the client computer, a pop up window 
asking you to enter an Administrator's ID/password of the client 
computer you selected will appear if you can't access through 
the password you set in step 7. 

• C drive must be shared as C$.
12. Select Software and Utilities to Install window appears.

Select the driver(s) and application software(s) you want to install and 
click Next.

13. Select Printer connection window appears. 
Select the printer connection type and click Next.
• If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

• The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

14. Confirm Group details window appears. 
Check the group information and click Next.

Location to save the group shows the path of default folder 
which stores the created group information. The group information 
file will be created as “<group_name>.RGI. You can change the 
path by clicking the Change button. 

15. Select Client Group window appears again.
16. Select the group(s) and click Next to start remote installation.

Remote installation begins, you can see the installation status from the 
window. 

17. When installation is completed, Results of remote installation window 
appears. 
Check the result. For failed client computers, you can reinstall again by 
clicking the Reinstall button.

For failed client computers, you can check the log file which is 
created in the client computers.

Error log messages

MESSAGE MEANING SUGGESTED
SOLUTIONS

Connection 
Error

Unable to bind the socket. 
[Port number:..]

Restart the client 
computer.

Unable to listen the 
socket. [Port number:..]

Unable to connect to the 
client computer.

Client computer’s socket is 
closed.
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CREATE CUSTOMIZED INSTALLER

Create Customized Installer allows administrators to create their own 
installation package with the installation setting you want. You can choose 
the drivers or software to be installed, assigned printer, printer name, 
sharing options, default printer and so on.
The created installation package can be distributed as a single 
self-extraction EXE package to clients through file servers or special 
distribution servers. You can also create an install script file for silent 
installation.

Creating a setup package
You can create a setup package from CD to a local folder. The created 
setup package will include only selected device drivers or application.
There are two types of setup package you can create. Normal(setup.exe)
and Self-Extraction Package. Normal(setup.exe) will extract only 
selected driver or application files from CD. Self-Extraction Package will 
package like normal installation CD package as a single self-extractable 
setup.exe file.
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

• The software CD should automatically run and an installation window 
appears.

• If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

3. Select Administrator Installation > Create Customized Installer.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Package Type window appears. 

Setup Error Unable to access the 
default shared folder(C$) 
in the client computer.

• Check if C drive 
folder is shared as 
C$.

• Check if you can 
remotely access the 
client computer’s C$ 
folder on a network 
browser.

Unable to copy service 
files.

Check if you can 
remotely access the 
client computer’s C$ 
folder on the network 
browser.

Unable to start the service 
on the client computer.

Check whether 
RMInstallService
program is running from 
Services. (From the 
Windows Start menu, 
select Control Panel > 
Administrative Tools > 
Services).
If RMInstallService is 
stopped then restart it 
and try remote 
installation again.
If you can't restart 
RMInstallService, then 
reboot client computer 
and try remote 
installation again.

Unable to create thread for 
monitoring.

Restart the client 
computer.

Unable to share folder on 
client computer.

Check if the shared 
folder in the client 
computer can be shared 
with full control.Unable to copy Installation 

files.

Unable to execute the 
setup file normally.

• Check if the same 
model’s installer is 
running.

• Check if the installer 
is waiting for a user 
input.

MESSAGE MEANING SUGGESTED 
SOLUTIONS

Unable to get 
profile

N/A Check if the 
environment of client 
computer is supported 
for installation.OS not 

supported

Internet 
Explorer not 
supported

MSXML not 
supported

Insufficient free 
space

Not
Administrator

MESSAGE MEANING SUGGESTED
SOLUTIONS
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Select Normal(setup.exe) or Self-Extraction Package.
If you place the mouse cursor over the package type, you can see the 
detailed information on the bottom right side of the window. 

6. Select Software and Utilities to Install window appears.
Check the device drivers or application software you want to included in 
the setup package and click Next.

7. Select Printer connection window appears. 
Select the printer connection type and click Next.
• If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

• The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

If you can’t search network printers on the network then check 
whether your firewall setting is disabled. If it is enabled, disable 
firewall temporarily and try searching again.

8. Set Printer Drivers window appears. Click Next.
If necessary, configure printer name, sharing, shared name and default 
printer setting. If you changed settings then you should click Apply
button to apply changes then click Next.

9. Summary window appears. Check the package information and click 
Next to start creating the setup package. 
You can modify the package configuration by clicking the Back button. 

Check the Install the package as silent mode, if you want to 
make the installation package as a silent installation package. 
Silent installation installs the driver automatically by the set option 
without user intervention. 

10.  When creating the setup package is finished, Packaging Completed
window appears. 
Check Open package folder upon completion if you want the created 
package to open automatically after it’s created. 

11. Click Finish.

Creating a setup script file
You can generate setup configuration script file based on the CD image. It 
can be used with Silent installation for distributing software to multiple client 
computers. For example, you can upload a full CD setup files into a file 
server then distribute batch file or log-on script file that executes silent 
installation with this customized script file(ex: \\<file_server>\CD\setup.exe 
/s /i”c:\temp\CONFIG.CI3).
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

• The software CD should automatically run and an installation window 
appears.

• If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

3. Select Administrator Installation > Create Customized Installer.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Package Type window appears. 
Select Generate a Setup script file.
If you place the mouse cursor over the package type, you can see the 
detailed information on the bottom right side of the window. 

6. Select Software and Utilities to Install window appears.
Check the device drivers or application software you want to included in 
the setup package and click Next.

7. Select Printer connection window appears. 
Select the printer connection type and click Next.
• If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

• The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

• If you can’t search network printers on the network then check 
whether your firewall setting is disabled. If it is enabled, disable 
firewall temporarily and try searching again.

• Setup configuration script filename is set as CONFIG.CI3 and 
it’s not changeable.

8. Set Printer Drivers window appears. Click Next.
If necessary, configure printer name, sharing, shared name and default 
printer setting. If you changed settings then you should click Apply
button to apply changes then click Next.

9. Summary window appears. Check the package information and click 
Next to start creating the setup package. 
You can modify the package configuration by clicking the Back button. 

Check the Install the package as silent mode, if you want to 
make the installation package as a silent installation package. 
Silent installation installs the driver automatically by the set option 
without user intervention. 

10.  When creating the setup package is finished, Packaging Completed
window appears. 
Check Open package folder upon completion if you want the created 
package to open automatically after it’s created. 

11. Click Finish.

Modifying a setup script file
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

• The software CD should automatically run and an installation window 
appears.

• If the installation window does not appear, click Start and then Run.
Type X:\Setup.exe, replacing “X” with the letter which represents 
your drive. Click OK.

• If you use Windows Vista, click Start > All programs > Accessories
> Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your drive and click OK.

• If the AutoPlay window appears in Windows Vista, click Run
Setup.exe in Install or run program field, and click Continue in the 
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User Account Control windows.
3. Select Administrator Installation > Create Customized Installer.

If necessary, select a language from the drop-down list.
4. Read License Agreement, and select I accept the terms of the 

License Agreement. Then, click Next.
5. Select Package Type window appears. 

Select Modify Script.
If you place the mouse cursor over the package type, you can see the 
detailed information on the bottom right side of the window. 

6. Open the script file you want to modify(ex:CONFIG.CI3).
CONFIG.CI3 script file will exist in \Setup\Script subfolder of the 
created setup package.

7. Select Printer connection window appears. 
Select the printer connection type and click Next.
• If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

• The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

• If you can’t search network printers on the network then check 
whether your firewall setting is disabled. If it is enabled, disable 
firewall temporarily and try searching again.

• Setup configuration script filename is set as CONFIG.CI3 and 
it’s not changeable.

8. Set Printer Drivers window appears. Click Next.
If necessary, configure printer name, sharing, shared name and default 
printer setting. If you changed settings then you should click Apply
button to apply changes then click Next.

9. Summary window appears. Check the package information and click 
Next to start creating the setup package. 
You can modify the package configuration by clicking the Back button. 

10.  When creating the setup package is finished, Packaging Completed
window appears.
Check Open package folder upon completion if you want the created 
package to open automatically after it’s created. 

11. Click Finish.

SILENT INSTALLATION MODE
Silent installation mode is an installation method that does not require any 
user intervention. Once you start the installation, the machine driver and 
software are automatically installed on you computer. You can start the 
silent installation by typing /s or /S in the command window. Silent 
installation can also be performed by using the command script file 
(See"Create Customized Installer" on page 93).

Command-line Parameters
Following table shows commands that can be used in the command window 
or in making a script file (See "Creating a setup script file" on page 94).

Following command-line are effective and operated when command is 
used with /s or /S. But /h, /H or /? are exceptional commands that can 
be operated solely.

COMMAND- 
LINE DEFINITION DESCRIPTION

/s or
/S

Starts silent installation. Installs machine drivers 
without prompting any UIs 
or user intervention.

/p”<port 
name>” or
/P”<port
name>”

Specifies printer port.
Network Port will be 
created by use of 
Standard TCP/IP Port 
monitor. For local port, 
this port must exist on 
system before being 
specified by 
command.

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name or IEEE1284 port 
name.
For example
•  /p”xxx.xxx.xxx.xxx” in 

where, “xxx.xxx.xxx.xxx” 
means IP address for 
network printer. 
/p”USB001”, /P”LPT1:”, 
/p”hostname”

• When installing the 
driver silently in Korean, 
type in-Setup.exe /s 
/L"0x0012” or 
Setup.exe /s /L"18” .

/l”<Lang_cod
e>” or
/L”<Lang_co
de>”

Sets language code.
The default language 
will be decided 
automatically if there 
is no specified 
installation language 
commanded. The 
default language 
depends on your 
system locale 
information.

Decimal number and 
hexadecimal number can 
be used but hexadecimal 
number must have prefix 
with “0X”. Refer to 
Language Codes section for 
available <Lang_code>.
This command applies to all 
machine’s drivers and 
application software if 
specified language is 
supported. All software 
included in the machine’s 
drivers will be installed as 
the specified language.
• Setup.exe /s /L"0x0012” 

or Setup.exe /s /L"18”   ; 
install setup package 
silently with Korean.

/a”<dest_pat
h>” or
/A”<dest_pat
h>”

Specifies destination path 
for installation. 

The destination path 
should be a fully 
qualified path.

Since machine drivers 
should be installed on the 
OS specific location, this 
command applies to only 
application software.
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Language code

/i”<script
filename>” or
/I”<script 
filename>”

Specifies customized install 
script file for custom 
operation.

The script filename 
should be a fully 
qualified filename.

Customized script file can 
be assigned for customized 
silent installation. This script 
file can be created or 
modified through provided 
installer customization utility 
or by text editor.
Note: This customized 
script file is prior than 
default installer setting in 
setup package but not prior 
than command-line 
parameters.

/n”<Printer
name>” or
/N”<Printer 
name>”

Specifies printer name. 
Printer instance shall be 
created as specified printer 
name.

With this parameter, you 
can add printer instances as 
your wishes.

/nd or
/ND

Commands not to set the 
installed driver as a default 
machine driver.

It indicates installed 
machine driver will not be 
the default machine driver 
on your system if there are 
one or more printer drivers 
installed. If there is no 
installed machine driver on 
your system, then this 
option won’t be applied 
because Windows OS will 
set installed printer driver as 
a default machine driver.

/x or
/X

Uses existing machine 
driver files to create printer 
instance if it is already 
installed.

This command provides a 
way to install a printer 
instance that uses installed 
printer driver files without 
installing an additional 
driver.

/up”<printer 
name>” or
/UP”<printer 
name>”

Removes only specified 
printer instance and not the 
driver files.

This command provides a 
way to remove only 
specified printer instance 
from your system without 
effecting other printer 
drivers. It will not remove 
printer driver files from your 
system. 

/d or
/D

Uninstalls all device drivers 
and applications from your 
system.

This command will remove 
all installed device drivers 
and application software 
from your system.

/v”<share 
name>” or
/V”<share 
name>”

Shares installed machine 
and add other available 
platform drivers for Point & 
Print.

It will install all supported 
Windows OS platform’s 
machine drivers to system 
and share it with specified 
<share name> for point and 
print.

COMMAND- 
LINE DEFINITION DESCRIPTION

/o or 
/O

Opens Printers and Faxes
folder after installation.

This command will open 
Printers and Faxes folder 
after the silent installation.

/f”<log 
filename>” or
/F”<log 
filename>”

Specifies log filename.
The default log file is 
created in the system temp 
folder if not specified.

It will create a log file to a 
specified folder.

/h, /H or /? Shows Command-line 
Usage.

CODE LANGUAGE

0X0009 English

0X0012 Korean

0X0804 Simplified Chinese

0X0404 Traditional Chinese

0x040c French

0X0007 German

0X0010 Italian

0X000a Spanish

0X0013 Dutch

0X001D Swedish

0X0006 Danish

0X000b Finnish

0X0014 Norwegian

0X0019 Russian

0X0005 Czech

0X000e Hungarian

0X0008 Greek

0X0816 Standard Portuguese

0X0416 Brazilian Portuguese

0X0015 Polish

0X001F Turkish

0X0001 Arabic

0X000D Hebrew

0x0424 Slovenian 

0X0418 Romanian 

0X0402 Bulgarian 

0X041A Croatian 

0X081A Serbian

COMMAND- 
LINE DEFINITION DESCRIPTION
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FREQUENTLY ASKED QUESTION
Remote Installation related questions

NO. QUESTION ANSWER

1 Client computers are not 
listed in the list when
logging on as a domain.

Primary DNS address in all client 
computers should be specified as 
your domain server.
If the client computer is turned off, 
turn it on.

2 “Cannot access” error 
message appears during 
workgroup remote 
installation.

This error message appears if access 
was denied. You should check the 
settings of network access; sharing 
and security model for local accounts.
• From the Windows Start menu, 

click Control Panel > 
Administrative Tools >Local 
Security Policy > Local Policies
> Security Options > Network 
access: Sharing and security 
model for local accounts.

• If the setting is not Classic – local 
users authenticate as 
themselves, change it to Classic 
– local users authenticate as 
themselves.

3 “Cannot access” error 
message appears during 
domain / workgroup 
remote installation

Check if the C drive folder is shared.
C Drive folder should be shared as 
C$ to access remote client 
computers.

Create Customized Installer related questions
NO. QUESTION ANSWER

1 When I try to open the 
CONFIG.CI3 script file, 
the files doesn’t open and 
a warning message pops 
up.

When the Custom utility opens the 
config.ci3 script file, it checks 
manufacture, model and script file 
type. Check the <MFG>,<MDL> node 
of the file you want to open, and if 
<SCRIPT_TYPE> value is ‘Config’.

2 I cannot precede the next 
step at Search Network 
Printer dialog.

It checks if the IP address/hostname 
is valid or not. You can specify only 
the IP address/hostname which is 
connected via network currently. 
Check the connection status of the 
printer to specify.

3 When I execute the 
customized installer 
package, the welcome 
dialog appears and I need 
to select the options 
again.

If you want to install as silent mode, 
check the Install the package as 
silent mode check box in the 
Summary window.

0X0422 Ukraine 

0X041B Slovakia 

0X0421 Indonesian 

0x041E Thai

0X0429 Farsi

CODE LANGUAGE
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE

ARGENTINE 0800-333-3733 www.samsung.com/ar

AUSTRALIA 1300 362 603 www.samsung.com/au

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com/at

BELGIUM 02 201 2418 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com/br

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com/ca

CHILE 800-SAMSUNG (726-7864) www.samsung.com/cl

CHINA 800-810-5858
400-810-5858
010-6475 1880

www.samsung.com/cn

COLOMBIA 01-8000112112 www.samsung.com.co

COSTA RICA 0-800-507-7267 www.samsung.com/latin

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com/cz

Samsung Zrt., eská organiza ní složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 8-SAMSUNG (7267864) www.samsung.com/dk

ECUADOR 1-800-10-7267 www.samsung.com/latin

EL SALVADOR 800-6225 www.samsung.com/latin

ESTONIA 800-7267 www.samsung.com/ee

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 30-6227 515 www.samsung.com/fi

FRANCE 01 4863 0000 www.samsung.com/fr

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.de

GUATEMALA 1-800-299-0013 www.samsung.com/latin

HONDURAS 800-7919267 www.samsung.com/latin

HONG KONG 3698-4698 www.samsung.com/hk

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com/hu

INDIA 3030 8282
1800 110011
1800 3000 8282 

www.samsung.com/in

INDONESIA 0800-112-8888 www.samsung.com/id

ITALIA 800-SAMSUNG(726-7864) www.samsung.com/it

JAMAICA 1-800-234-7267 www.samsung.com/latin

JAPAN 0120-327-527 www.samsung.com/jp

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 02 261 03 710 www.samsung.com/lu

MALAYSIA 1800-88-9999 www.samsung.com/my

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com/mx

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com/nl

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com/nz

NICARAGUA 00-1800-5077267 www.samsung.com/latin

NORWAY 3-SAMSUNG (7267864) www.samsung.com/no

PANAMA 800-7267 www.samsung.com/latin

PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com/ph

POLAND 0 801 1SAMSUNG 
(172678)
022-607-93-33

www.samsung.com/pl

PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com/pt

PUERTO RICO 1-800-682-3180 www.samsung.com/latin

REP. DOMINICA 1-800-751-2676 www.samsung.com/latin

EIRE 0818 717 100 www.samsung.com/ie

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com/sg

SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com/sk

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE
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SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com/za

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com/es

SWEDEN 075-SAMSUNG (726 78 64) www.samsung.com/se

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com/ch

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232
02-689-3232

www.samsung.com/th

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com/latin

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864)
8000-4726

www.samsung.com/ae

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com/uk

U.S.A 1-800-SAMSUNG 
(7267864)

www.samsung.com/us

UKRAINE 8-800-502-0000 www.samsung.ua

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1 800 588 889 www.samsung.com/vn

COUNTRY/REG
ION

CUSTOMER CARE 
CENTER WEB SITE
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glossary
The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g
802.11b/g can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps; 802.11g up to 54 Mbps. 
802.11b/g devices may occasionally suffer interference from microwave 
ovens, cordless telephones, and Bluetooth devices. 

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a pseudo standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and flip over an original sheet of paper so that the 
machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.
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DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 
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Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 

compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.  

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.
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NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or gray colored and a cylinder shaped. 
An exposing unit of a drum is slowly worn away by its usage of the 
printer, and it should be replaced appropriately since it gets scratches 
from grits of a paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, matrix printer, and page 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle within a machine like printer which contains toner. Toner 
is a powder used in laser printers and photocopiers, which forms the text 
and images on the printed paper. Toner can be melted by the heat of the 
fuser, causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.


